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Network Inventory Enterprise 5 Introduction

Chapter 1: Introduction

Network Inventory Enterprise is an award-winning network inventory software for organizations
of any sizes. It offers features for remote audit of every PC in your network without having to install
client modules. By using Network Inventory Enterprise you can get detailed hardware, software
inventory and licensing information from all remote PCs within seconds. Powerful reporting module
helps you save a lot of time for preparing network PC inventory and network audit reports.

How much time do you spend on network inventory? How accurate and detailed your audit
information is? Do you know what is your actual configuration now? Network Inventory is network
audit software created to provide you by actual hardware and software audit information with no
efforts from your side.

How this network audit solution can be helpful for you? First of all, it is able to make remote audit in
automatic mode and collect information about hardware and software assets from remote computers
in a few moments. It means that you always have up-to-date network inventory database with all
assets, their settings and specification. This database can be used to generate audit reports and
answer questions like:

e Which desktops lack free space on their hard drives?
e Which have Windows XP and have less than 1 Gb RAM?

¢ How many additional software licenses are required?

Main Features

Network Inventory is a tool that helps you automatically collect up-to-date information about all
hardware and software assets from all remote PCs in your network into audit database and use it to
quickly find required inventory information and build network inventory reports. With this network
inventory tool you can get detailed network audit information in just few mouse clicks without any
network environment configuration tricks, logon script or WMI manipulation or client installation to
remote computers.

PC Inventory

Collect complete hardware and software audit information from all remote PCs in few minutes
without physically attending them. Use modern network inventory scan approach, which doesn't
require complicated configuration or client installation to remote PCs and is able to work in different
environments.

e Unattended Remote PC Inventory
e Clientless Remote PC Audit
e Large Networks Audit

e Fast Remote PC Inventory Scan

Software Inventory

Make remote audit of installed software to get a high-level overview of used applications, guarantee
licenses compliance and optimize software purchases and upgrades. Get software report for
particular PC or entire network. Identify forbidden applications and resources on remote PCs.

¢ OS and System Information for Every PC
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e Installed Software Inventory
e Software License Compliance Audit

e Installation Changes Tracking

Hardware Inventory

Perform automatic network audit and get general overview of all hardware assets installed on remote
PCs. Get information about configuration of each particular PCs. Easily find where particular
hardware component is installed. Simplify hardware upgrades and optimize your purchases.

e Remote Unattended Hardware Audit
e Hardware Inventory Information for Every PC
e Detailed Assets Specification

e Aggregated Hardware Assets Overview

Inventory Report

Generate detailed network inventory reports based on collected network audit information using a
set of clear, accurate and nice-looking inventory templates. Save produced reports in one of popular
formats. Customize existing or design own reports. Integrate your application with network inventory
system.

e Automatic Inventory Report Generation

e Hardware and Software Inventory Reports

Software Compliance Report

Easy Reports Customization

Copyright © 2001-2018 EMCO. All rights reserved. 4
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Chapter 2: User Interface Overview

The main application screen is divided on two parts. At the left side you can find Machine
Management area that displays the network tree and asset groups. Management toolbar E¥ is used
to execute main actions, for example, scan network or update inventory information. The full set of
actions is available from the context menu on the tree.
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Pic 1. The main application screen
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The Machine Tree is located under the management toolbar and contains asset information that
can be represented by two ways. The Entire Network node E | displays PCs found in the network,
grouped by domains and workgroups. When some node under the Entire Network is selected, on
the right side you can see related inventory information. For example, if you select particular PC,
you can see its hardware and software assets summary. If you want to learn more about concrete
asset, for example processors on particular PC, you can select Processors under PC's node in the
tree and get detailed information.

Other nodes in the Machine Tree represent particular asset category for all computers in the
network. Thus, if you need to check monitors information only, you can expand Monitors root node
in the tree and select domain/workgroup or particular PC to get information for them.

In order to manage application settings you can switch tabs located under the Machine Tree. ®
The Settings tab allows you to manage information extracted from remote PCs, so you can enable
or skip some parameters. The Alt Credentials tab is used to set administrative credentials applied
to access remote PCs. If your account doesn't have administrative permissions on remote PCs you
need to set administrative account on this tab.

Information displayed on the right side of the main screen depends on the node, selected in the
Machine Tree. For example, if PC node is selected, at the right side you can see Machine
Summary information. Management toolbar ) is located at the top of the summary and provides a
quick access to the most frequent actions, such as report generation, locking and update functions.
Under the toolbar B you can find Hardware, Software and System Information boxes with the
correspondent information about PC.
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Chapter 3: Getting Started

This chapter is a starting point for everyone, who would like to see how to make software and
hardware audit of remote computers with the Network Inventory Enterprise. If you are making first
steps with the application, this tutorial will help you to quickly familiarize with main features of the
product.

Any company and organization needs to have hardware and software inventory information in order
to plan upgrades or hardware/software purchases. This information gives you an overview how many
and what exact hardware and software assets do you have and helps to identify what assets you
need to add or replace.

Today every PC has tens applications installed and consists of dozen components, including CPU,
memory, motherboard, hard drive, etc. Manual collecting inventory information from one PC can take
up to ten minutes. How long does it take to make inventory of tens, hundreds and thousands PCs in
your network? Also consider the fact that to be useful inventory information should be up-to-date.
It's not enough to collect assets information at the purchasing time, because afterwards
configuration can be changed - administrators can replace or remove some hardware, users can
install new applications, etc.

Is there an effective way to make the software and hardware audit? Network Inventory Enterprise
allows automatic collecting hardware and software assets information from remote PCs and gives
you few advantages:

e Fast automatic collection of asset information that significantly reduces your time and efforts

e Always up-to-date inventory information helps you to make decisions easier

What's Inside

Collect Hardware and Software Information from Remote PCs
Browse, Filter and Analyze Inventory Information

Prepare Inventory Report

Reconcile Software Licenses

Detect Licensing or Policies Violations on Remote PCs

Copyright © 2001-2018 EMCO. All rights reserved. 7
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Collect Hardware and Software Information from Remote PCs

As you may know, Network Inventory allows you to make hardware and software inventory of
remote PCs without installation of any agents on client computers. It simplifies the process, because
in order to prepare to the remote inventory you just need to check only two things. First, you need
to have administrative access to remote PCs. If your current account doesn't have administrative
permissions, you need to go to the Alt Credentials tab and setup credentials there. Second, you
need to switch to the Settings tab and check what data will be collected from remote PCs. Please
note that some data is collected through the Windows Management Instrumentation (WMI), so this
service should be enabled on remote Pcs.

Collection of inventory information is activated by the Enumerate LAN button located on the
management toolbar. This button launches the network enumeration to detect PCs in all available
domains and workgroups within the local network. Inventory information is extracted from all remote
PCs and stored in the local database. If you would like to reduce the range of scanned PCs, you can
choose other options, like a scan by IP range, available from the Enumerate LAN pop-up menu.

Power your business with up-to-date inventory information
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Pic 1. Enumerate LAN options
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After a scan the Machine Tree displays detected PCs grouped by domains and workgroups. You can
browse the tree to see inventory information for the selected tree node. Thus, you can see asset
information for workgroup/domain or PC or components of particular PC, etc.
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Power your business with Up-l‘D—d ate inventor}r information f‘[’.’ﬁ
Intelbgent inventory sustem for keeping ack of your hardwase and soltwate assels across the nelwork anlime. I

() Enumerate LAN ~ i FelchMew = @8 Lodae = 8

| a B | x o Actions - h\f“&h’ﬂfkﬁhh,l S} oy "‘ P i 1 .L L 'wf _Il;g.-;.. -:..': y
@ Entire Network. - (61] - - : -
63 105 Instalod Apphcations | [ hdd dete | [ Export Displayed Network Cards: 3
# Custom Scan Resuls Netwark lNet\wk Cards
1ot Shases e wm— e T T P o T T e
W8 Monitors DREAMLIGHT PDC_ ImkelRt] PRO/I000 MT Netwolk Conn., 19216353 255,090,250
B (ElPiirlers MERCURILS Marvell Yukon BRESODT/B00/BNO ... 19216813 2552952550
& 5] Diive Mappings WHPPROMEASPT  IrtelR FRO/1000 MT Mebwolk Conn . 0,000 v

| #-w Physical Diives

| 5 Logical Drives
&4 CD Diives
-8 Aunning Processes
&5 Statup Commands
#H_ Program Foldess
@ Processors
=1 e Metveork: Cards

{[1]

& 'w® EMCD
[ " LABORATORY
=" TYRONE

=l WINTOOLKIT

- B, Emdronmental Varisbles
-5y Services

= Memory Banks

= gl ODBC Data Sowces

B & Hotlines

#-5 Scheduled Tasks

- A Fortz : ) *l
W Manage ) Seltings oA Al Credentisls

k= et G

Pic 2. Inventory scan results

When you make the first scan, the Machine Tree is filled by the collected data. Next time, when
you need to make an inventory, you can choose to collect information from the new PCs available in
the network, or to update information on existing PCs in the tree. In this case you need to use
Fetch New or Update buttons on the management toolbar. If you make Enumerate LAN, then the
network scan and the data collection procedure will be repeated again and your current data will be
replaced by the new one.
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Browse, Filter and Analyze Inventory Information

When collection of inventory information is finished, you can browse it by selecting required nodes in
the Machine Tree. By this way you can get inventory information for each particular PC or the
general overview for particular asset across the network. But if you have hundreds or thousands PCs
in the network, it's hard to find required information.

Network Inventory can help you to easily manage and narrow information by applying filters. For
example, let's detect problematic PCs, which have a lack of memory. In order to find them, select
the domain or workgroup under the Entire Network node in the tree. Summary information about
PCs in this domain or workgroup is displayed on the right side. This information includes Physical
Mem field, so we can apply filter by this field to display only problematic PCs. Click on the down
button on the field's caption and in appeared menu select (Custom...) item. On the Custom
AutoFilter dialog select is less than option and enter 512 value to display only those PCs, which
have less than 512MB of memory.
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Pic 1. Custom AutofFilter dialog
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After applying the filter the displayed data will be updated to show only those PCs that fulfill the
filter condition. [=lEd
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Pic 2. Scan results with applied filter

Note that you can apply multiple filters at once, for example to detect PCs that have Windows Vista
and a low memory.
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Prepare Inventory Report

Collecting information from remote computers is only a part of inventory task. Usually, the asset
information should be composed into printable reports for the management or further reference by IT
team. Network Inventory provides few easy ways to prepare reports. First, you can save information
displayed on screen in various formats if you click on the Export Displayed button. Second, you
can generate a set of detailed predefined reports. Third, you can your own custom reports.

All reports are customizable. It means that you can change the title page and put your name and
company logo to it. To customize report select File > Preferences... item from the main menu and
go to the Report tab. Change report Title, Description and set Author and Company Logo.

Press OK button to apply settings.
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Pic 1. Report customization options
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Let's create inventory report in PDF format for all PC. To generate the report select Reports >
Machine Data > Export to File > All item from the main menu. On the appeared Field Output
Selection dialog you can choose what data should be included into the report. Pic 2
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- - 4 LI
Wt Manage (  Seitings 7%, Alt Credentials L i

Pic 2. Field Output Selection dialog
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Make you selection, press OK and proceed to the Save As dialog where you need to enter the file
name and choose Adobe Acrobat Document as output format. Press Save button to generate the
report and open it in the Acrobat Reader. You can see logo and customized captions on the title

page.

| reportpof - Adoee|

File Edit View I ocument  Tools ndow Help

g:p@r@ $ 1 /0 & ® ws% - | = o Find

EMCO Software

Inwentory Report

Hardware & Software Assets Sumary

Pic 3. Report title page
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Other pages contain information selected for inclusion into the report. [ Pic 4

'@%|@*E|”\@@|E3|@@||ﬂ CommentiShare

Machines Hardware & Software Report

* ™ Basic Information

Machine MERCURILS
DomainWorkgroup DREAMLIGHT

2 Summary Hardware Information

# Mother Board & Processor

System Name ASUSTek Computer INC. PSGZ-MX

Scan Date: 7/20/2011 12:25:38 PM
IP-Address 192.168.1.10
MAC Address 00-18-F3-7F-1C-1D

DREAMLIGH IERCURTLIS

Scan Date: 7/20/2011 12:35:38 PM
w - Physical Drives

Disk 0 SAMSUNG HDOBOH] ATA Device (74.53 GB)

Processor Intel{R) Core{TM)2 CPU 4300 @ 1.B0GHz U@ﬂ' Drives
Processor #2  Intel(R) Core{TM)2 CPU 4300 @ LBOGHZ s
) X Local Disk C [EEMMMSE™ | 10.23 GB of 37.42 GB free

= Memory Local DiskD [ #% | 35.75 GB of 37.11 GB free

Total Memory 2.00 GB
Available Memory 1.57 GB 4 Other
Memory Slot 1/2 1,00 GB installed  Capacity 4,00 GB Printer Fax

Memory Slot 2/2  1.00GB instalied  Capacity 4.00 GB Printer £2 Microsoft XPS Document Writer
Metwork Card Marvell Yukon 85E8001 /800378010 PCT Gigabit

Ethernat Controller

Monitor SyncMaster
Video Card MNVIDIA GeForce 8500 GT
Resolution 1280 x 1024

DREAMLIG IERCURIL

<1 Summary Software Information Scan Date: 7/20/2011 12:25:
A Operating System e O

0% Type Workstation Default Browser IExphore

Service Pack Service Pack 1 Windows Directory  C:\Windows

Build Mumber 7601 Profiles Directory Cr\Usars

Product 1D " : Default Language  English (United States)
Digital Product I~

Pic 4. PC Summary report

Now you are familiar with a sample of building a report and configuring the report presentation and
can create inventory reports fast and easy.
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Reconcile Software Licenses

A list of installed applications for each PC is available under the Installed Applications node in the
Machine Tree. It represents the same data as displayed by the Add/Remove Programs in the
Control Panel. But if you have a lot of computers in the network, it's very hard to get the general
vision what software is used in the organization, because the information represented per PC.

The summary information about software used within organization is available on the Machine Tree
under the Management Tools > Installed Applications. The Count Application node opens the
dialog that represents all software items found in the network together with the number of used
copies. It helps you to have the summarized information about all software assets. But such
representation has two disadvantages. First, it includes a freeware that should be often skipped
from the software assets evaluation. Second, it groups software by the full name coincidence, so
same applications with different version numbers can be represented few times in the list.

- e

| (&) Erumesate LAN = i FetchMew » ) Updsle ~

| 3@ Processors
(- e Metweotk: Cards
- B, Ervirorureental Vasiables
¥ 5y Services
| 5= Memory Banks
|| @ ) ODBC Data Sowces
# $‘ Hotfoes
% Scheduled Tacks
;4: A Forts
-G U Accounts
5 ;” Metweork Protocols
K MNotes
# ﬂl; Scan Dpesations
|4 Management Tooks
I3 Custom Scan Citeria
{ 7 Latest Fetched Machines
] Irstaled ﬁlloitalms
%
1] Dmsru L-:-u
] Compaie Licenses
4+ Reconcle Licenses
3] Mairasin Master List
) Mainkain Groups List
5] Maintain Licenss Cost Base
& Mairtain Exchde List
1 Maintain Frequently Used Holes
% Wiew Ermor Log-File

.ﬂ

I

®

L

w® Manage kgw i AR Credentials

View Hepurt;leuuy El.'ll'dﬂ' Scan Operations ManagemmtTunh

Power your business with up-to-date inventory information
Inteligent imsenbory sistem for kesping ack of your handware and software assetls scrogs the network, amdime,

Ogtions  Live Update Help

(= =X 9 Asions + )
| #C_7 Program Folders -

L1

@ Installed Applications Count

Installed Applications Count

Renviews how many copies of an application are inctalled onmachines within 2 network, You can
alzo look on whech machines speciied appbeation is mstalled by peessng Town' bulton rear

inztalled appication Label
[ Expot | @ Chat | 2 Repon

w

Narie

Acrobat com

4 Adobe AR

1 Adobe Reader 3

1 Apphcation Vesihier [x64]

1 CRUID CRU-Z2 1.531

1 EMCO Remobe Deskiop Entespize

i?

2 Hotfes fos Windows Serves 2003 [KBS54550+7)
4 Hotlee fos Windows Server 2003 [KBI51118)

4 Hotfes for Windows Server 2003 [KBIT0ES33)
2 Hotfe Bor Windows =P [KBIS4550-5)

1 Marvel Mirapodt Dirtver

1 Microsolt HET Framework 1.1

2 Microsolt MET Framewsork 210

4 Microsoft HET Framewsork 210 Service Pack 2
1 Microsolt HET Frameveork: 20

4 Microsoft MET Framework 20 Service Pack 2
S Microsolt HET Framework 35 SP1

1 Microsolt MET Framevsork 4 Chent Poolle Beta 1
1 Microsoft HET Framewsork 4 Extended Beta 1

H A A A4 Afd (A A Ao A (A Ao (A A4 4

B el

5 Hetlo: for Mizrasolt HET Framewrk 35 SP1 (KB353535)
5 Holfee for Microsolt MET Framework 35 5P [KBI52484)

D L L i Tt = I

m

e

Pic 1. Installed Applications Count dialog
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To filter out applications from the summary view, the Installed Application Exclude List dialog can
be used. It is activated by the Maintain Exclude List node. In this dialog you can define a

application name mask to remove all occurrences according with mask from the applications list.
Pic 2

File View Reports Options  Live Update Help

Power your business with up-to-date inventory information
Inteligent imentory system for keeping ack of your handware and software assels acrogs the network, amdime,

SOL Query Builder Scan Operations  Management Tools

@Ermnanﬁ.N' ] FelchMew ~ 3. Updste -

ate ﬂ Lock Machine

!-m

J b ProganFolies P Edlt| - RzadUrﬂyFbelds

o]
Machine: MERCURILIS IP-Address:  192.163.1.10
Domain'\Workgroup: DREAMLIGHT MAC Address:  00-18F3-7F-1C-10
r;? Installed Application Exclude List =6 =
Manage excluded applications =
== Schedued Tagks MWHﬂqummmmMmlmemmmhma ‘
A Fords
g?:wm (2 tnset | (7 Edt | B oo [ Ewpot (3 Delets
5| Notes | Dizplay Mame Mask to Exclude |v§|l-:mmmm_[:a_u [vj|Emrrm_Ha_pm [vj]
- Scan Dpesstions Skype” [ [
[, Management Took Sudveision” [] ]
[C] Custom Scan Citerda [
{ ] Latest Fetched Machines
=i g“w Installed Application Exclude
[l Changs Log Enter the application to be excluded details =
ECmpuuwam Thee appbcation will be added to exchuded kst 4
Reconcie Licenses
31 Mairkain Master List e .
7] Mainkain Groups List [Display Hame Mask | "update* wl
/%] Mainlain License Cost Base Exclude fnom Data O
o Mairitain Exnchade List I Exchude from R
1 Maidain Frequertly Used Hd s
174 Wiew Error Log-Fie
0 Manage (%, Setings T4, &8 Cee
& L

Pic 2. Installed Applications Exclude List dialog
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The similar functionality is available for application entries grouping. Using the Maintain Groups List
node you can activate dialog where set the mask and group name. All entries compliant to mask will
be replaced by the defined group name. [ Pic 3]

File View Reports SQL Query Builder Scan Operations Management Tocls Options  Live Update

Fower your business with up-to-date inventory information
Inteligent innentom sushem for kesping ack of vour hardwate ard sollwate sssels soross the nelwork artine.

Help

(&) Erumerate LAN ~ G FelchMew = @ Updue -
o Acions =

-

"

i PR TN N g
o ele w200 061193451

Fi

Machine: MERCURILIS IP-Address:  192.165.1.10
Domain\Workgroup: DREAMLIGHT MAC Address:  00-18F3-7F-1C-10
Description: Custom Datal:
@ Installed Application Groups List (=18 &
™= Manage installed application groups -
H &[] Fords Cieate v, Moy existing of Dedete irestalled appbestion sroups, a
& EUMM
fﬁ:wﬁm (5 lnoen | B £ B Do
- Scan Dperstions Priceity | = || Exclude Fiom Fe.. |+ | Display Mame ||| Group Mask -
-] 2 Management Tooks 1 L] fudobe Fesde
Custom Scan Critena - T
[ Latest Fetched Machines Installed Application Group
2@ mﬁ - Enter the application group details i
% M’L’;W The appécation group info will be created according tothe detads
- specified
£ Compae Licensss
43 Reconcle Licenses Display Mame Arkobe Fiesder
] Mairkain Master List Exclode From i
55 Mairtsin Licenee Cost Baze [GrowpMask | Adobe Reader
4] Mairtain Exchade List
1 Maintain Frequenly Used Hote:
4, Wiew Ewror Log-Fie
B Manage (O Setings (T 8 Ciede
far |

Pic 3. Installed Applications Groups List dialog
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Finally, when freeware is filtered out and all groups are defined, you can select the Reconcile
Licenses node to open correspondent dialog.

SOL Query Builder Scan Operations Management Teols Options  Live Update  Help

Power your business with up-to-date inventory information "_!
Inteligent imventory system for keeping rack of your handware and software assels across the network, amdime,

(&) Erwmerste LAN + 1] FelchMew ~ @ Lpdoe = igan h- . i = _El-' i
=1 3 Ar - 5 L i A I i - —
= X bt s Reconcile licenses
B Program Foldess & Review how mary icenses for a particular products are cusently avalable. Also pou can perform a
-l Processons Reconcly opesion which genesbes report based on Boanses” miomation,
1 o Netwok: Cards
| - B, Ervvironmeental 'V asiables % Expot [d Reconcle
| & S Sancns [ [Count | is0S| Display Name \Uicenses | Urwsed | Requied| Cost Per | Mot = |
B e s [ 3 ¥ Windows 2000 Fjes 3 [ B
4 ODBC Data Sources 4 = = 8
B Hotloes (2 11 ¥ Windows 2003 3 0 2 EE ||
| 875 Schedued Tacks I} 3 ¥ Windows NT4 L L - E
- |A| Fordz o 4 [ windows Vista 7 3 0 E
Eﬁmm J 3 ¥ Windows 3P 5 2 0 G
’ Nm‘““““ crocals ] 3 [] Acobat com 0 0 3 E |l
@b ScanOpessiions il 2 4 [ AdobealR 0 0 4 cll |
£ [ Management Tools (2 1 [] Adobe Reader9 0 0 1 G
(G Custom Scan Citeda 2 1 [ Appbcation Verfier [+64) o 0 1 B
L] Latest Feiched Machines 2 1 [] CPUIDCPUZ 1521 0 0 1 B
E"b_tﬁ‘ﬂ”wﬁ 4 1 [ EMCO Remote Desktop Enterpe: 6 5 0 c i
Change Log (3 5 [ Hotio: for Mictosolt NET Framew 0 0 5 G
g Compate Licenses = (2 5 [ ] Hobio: fee Micsoseit NET Framew 0 0 5 G
! Flecancie Licenses 2 2 ] Holfw for Windows Server 2003 | o 0 2 E ||
131 Maintam Master List 2 4[] Hotfx for Windows Sarver 2003 0 o 4 E ||
o Mehisn e Lt R 4 ) Hotfx for Windows Server 2003 0 0 4 G
%‘ e e o B 2 2 (] Hotfs for Windows P [KBS5455 0 0 2 G
1 Maintain Frequently Used Holes 2 1 [ Marvel Minipon Diives ] 0 1 G
4 View Eires Log-File L4 2 1 L] Microsoft NET Framewcsk 1.1 0 0 1 E
) ) -l & 2 [] Miciosoft MET Framewodk 2.0 0 0 2 .
‘!!HW/(}';EM { T & Credentials i< T] | v |
_———— e || |

Pic 4. Reconcile Licenses dialog

This dialog can help you to review all software assets. You can see a number of used copies for
each application and can enter the number of licenses that your organization owns to get the
number of unused or required licenses. Such approach can easily shows licensing problems and
simplify decision making for software purchases.
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Detect Licensing or Policies Violations on Remote PCs

Network Inventory has an ability to make a custom search on remote computers. You can define
specific conditions to search resources on the file system and registry. This feature is useful in
various cases, for example, to detect remote PCs with specific resources, settings or viruses, etc. It
can help also to detect licensing or company policies violations. For example, let's detect PCs that
have MP3 files on hard drives.

Remote search options are available under the Scan Operations node in the Machine Tree. To
make a files scan select File System Scan node and press Add button to configure a new scan
task. On the appeared Add Scan Task dialog enter scan task name and description.

Lq] -i"'.""nu - — .

Ele View Repomil;_ﬂ.QuuyEulldHS-ungpuman; ManaggmmtTnuls

Opfiors” Lvelgdde Sy

Power your business with up-to-date inventory information
Inteligent inmventory sistem for keeping rack of your handware and software assels scrogs the network amdime,

| () Enumerate LAN = 4 FelchNew = 0

= 3% @ hcions + 7 &H&Sﬁt&lﬂ&:ﬂn

- Erflie Metwark - (61) | -

| - Installed Appbc slions o Add ' elete Tasks: 0

| ® 7 Custom Sean Resulls [ Scan Tasks ‘
=

| ﬂéiﬁ:ﬁﬂ | |[Name = | Descrplion
4 als i
&1 Piinters Add Scan Task S
e E5] Dirve Mappings Enter the Scan Task nd tion =
5w Physical Ditves n e n name and descrip 4*

B> Logical Diives The Scan Task wil be created with the name and desciiption specified.

CD Drives
:Itﬂmrgﬁccusses ScanMame: MF3
15 Startup Commands
EH_ Program Foldess Description:  Lock for all P2
1 Processos
] Metweork Cands
&1 B, Ervaronmeental Vasiables

5y Services ;]EK \—Iw
&= Memoey Banks
& t]DDEEDaIaSmces _
4@ Hotfizes
@1 71 Scheduled T azks
®- Al Forts
w0 L ses Aceauris
&1 Network Frotocels
@ Motes
B¢k Scan Opesations
L=t File Siystem Scan
7] Regishy Scen
+ '_'»'i_h'la'mgemert Tools )
W Manage ( x Seltings ¢, &t Credentials
| destavk

Pic 1. Add Scan Task dialog

Copyright © 2001-2018 EMCO. All rights reserved. 20



Network Inventory Enterprise 5 Getting Started

New scan task will appear in the tree and you can select it to configure conditions. Click on the Add
button on the toolbar and on the Add Scan Criteria dialog 1S enter file mask *.mp3 and select
%AIl Drives% as a search criteria to look for MP3 files on all available drives. Press OK button to
finish.

View Reports 50l Query Builder 5can Operations Management Tools

Options

Power your business with up-to-date inventory information
Inteligent irventory system for keeping Irack. of your hardware and sollwate assels scross the nelwork arglime,

Live Update Help

() Enumerate LAN = £ FetchNew + B Lioe =

EX TS
E;'mmmm | Add 5Scan Critenia
| '?J_ts:ﬁmscm Results Spexify file scan data o
Bl id Sheees The Scan Criteria vil be created according to the specied data. 4
Search For
s Phypsscal Dives Specily file namels] or mask(z] to seach for
# Logeal Diives “mp3 -
|| #L CD Drives
#1-3 Funning Processes Seachln ——
Elglﬁtodwﬁmm Irpat path o sedect one of the predefined variables lrom drop-down ist:
&2 Program Foldess WAL Diives® - i
w8 Processors — )
1 e Metwork Cards E‘ Include Sub-Directories
&1 B8, Ervaronmental Vanizbles Parametess
Bl Gy Services | Inchade Product Mame and Fie Vession infoemation
&= Memory Banks - ae eraen
&- gl ODBC Data Souwces
5@ Hotlises Coberia Hame:  File Scan Critena #0
&% Scheduled Tagks
# Al Forts
FHET User Accaunts
&1 Metwark Protocals
-7 Notes
&£ Scan Dperations
=1y File Syshem Scan
> [
47 Reagsty Scan
El-ﬁh'la’mgerru_eﬂ: Toolk: )
¥ Manage (% Setfings - 75, Al Credenitials
=

Pic 2. Add Scan Criteria dialog
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Next, we need to configure the search scope, so click on the Include Machine button located on
the Machine Queue toolbar. On the appeared Add Machines to Queue dialog Pic 3 you can
choose domains/workgroups or individual PCs where search should be performed and press OK

button to fill the Machine Queue.

File View Reports 35S0L Query Builder 5can Operations Management Tools

Power your business with up-to-date inventory information
Inteligent inmventory sistem for kesping rack of your hardware and soltware assels scrogs the network, amdime,
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Pic 3. Add Machines to Queue dialog
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When search conditions and Machine Queue are configured, you can launch the search by pressing
Run Now button on the toolbar. After scan completion you can see search results below. To
get a detailed report about resources found, you can click on the row in the search results.

f. File View H_epq 0L Query Builder 5can Operations Management Tools Options  Live Update Help

Power your business with Up-l‘D—d ate inventor}r information
Inteligent inventory sustem for keeping rack of your hardwase and soltwate assels across the nelwork anglime.
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Pic 4. File System Scan results

Now you are familiar with File System Scan and you can use it any way and any time you need.
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Chapter 4: Network Management

Network Inventory interaction with network is designed in a way that makes it fast and easy to
search for Machines all over the network and collect inventory information for them. Network

Inventory saves the network structure in its database along with inventory data and represents it in
a form of a tree.

This chapter's target is to get you know how to review the information from this representation,
manage it and what can be done over network elements available for you from the Machine Tree.

What's Inside

Machine Tree
Enumerating Network Automatically
Fetching new Machines

Adding Machines Manually
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Machine Tree

The Machine Tree is located on the left of the main application screen under the Manage tab and
consists of grouping nodes that allow you to browse inventory information fast and easy. The main
node that contains all the information inside is the Entire Network node. It contains the Machines
found during the Enumeration, fetched or added manually. The child nodes of each Machine are the
nodes representing inventory information about this Machine.

() Erumersts LAN » i3] FatchMew = 3/ Update =
=R X O Actions -
- Eniire: Netwoak: - (23) -
) Microsoft Windows Netwerk
G w® DEV
= w® DREAMLIGHT
@ B DREAMLIGHT-PDC
ORwIMERCURIUS |
A B W05 PY
= B W PPRO-ES-SPT
) w® EMCO
= LAR
- B 2003E4- 5P
== LABORATORY
w5 L ABPOC
- B 00052
= TYROME
& B TYRONE-PDC
= B WNT5FE
= W WINTOOLKIT
& B N TOOLKIT-FDC
)71 Installed Appbestions
B ] Custom Scan Reauts
B e Shares
-8 Monitors
= Printers
[ 5] Dvive Mappings
s Logecal Dunves
Be CD Dtz
-5 Running Processes
5] Startup Commands -
a® Manage }gidlhgs i1 AR Credentials

m

Pic 1. Machine Tree

It is not always comfortable to see all inventory information under each Machine that is why the
other grouping nodes, except the Entire Network, are also present to show the individual accept of
the data collected for each Machine. For example, selecting the Machine under the Monitors node
gives you the same information as selecting the Monitors node under this Machine within the Entire
Network node. This is very useful feature if you want to browse just particular inventory
information for all the Machines.

There are also additional management nodes in the Machine Tree to be used for Custom Scan
functionality and Management Tools node containing the short cuts to the installed applications
inventory features and the error log.
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Enumerating Network Automatically

Network Inventory comes with a built-in network scan engine that allows you to scan an entire
network for available Machines with just one click. It is possible to enumerate domain or workgroup,
just some IP range from a group or the whole network. There are four possible ways of enumeration
and all of them are described in this chapter.

Enumeration means full rescan of the specified enumeration scope (network or group) so the
Machines not found during re-enumeration are deleted from the Machine Tree along with
there data. If you have already enumerated the network and just want to add more Machines
that are now available on the network but not available in Network Inventory use Fetch New

feature.

L£E

Enumerate All

Enumerate All means scanning whole network for the available Machines. To start such a
enumeration process press Enumerate LAN button on the tool bar above the Machine Tree. When
the enumeration completes the Machines found are displayed in the Machine Tree grouped by

workgroups and domains.
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Pic 1. Enumeration results for the whole network

Enumerate Selected

Enumerate Selected feature should be used to rescan for Machines only the selected group. To
perform such enumeration select the group within the Machine Tree and select Enumerate
Selected from the drop-down options of Enumerate LAN button on the tool bar above the

Machine Tree.
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Enumerate via IP Range

If the target is to retrieve only the Machines with a specific IP addresses from a workgroup or
domain the Enumerate via IP Range feature should be used. To enumerate a specific range select
Enumerate via IP Range option from the drop-down options of Enumerate LAN button on the tool
bar above the Machine Tree. The Enum Via IP Range dialog will appear on the screen.

Enum Via IP Range ﬂ
r Manage IP Ranges for enumeration
| i Althe Machines from the selected IP Rlanges not found whils 4"¢
| enurmeration will have thea diala kst A
[ Jncent [ Ect [2 pelete
Prorvides Damain Flemh'a |

IP From) lP To |

-:-

AT A I

Lok || GCancel

Pic 2. Specifying IP Ranges to enumerate

Within the Enum Via IP Range dialog you are to specify the IP Ranges to be used for enumeration.
To add an IP Range press Insert button on the tool bar over the ranges list. The Via IP Range
dialog will appear on the screen.

"l.l'ia[F' Range ﬂ‘

Enter the IP Range details s
The IP Range vwall be creabed accoiding to the detads specihed "'#

Provides Micaosodt Wirdows Hetwork
Dormain DREAMLIGHT

IF* [From) 19216851

Fianged

IPTe

Fesohee to Host

Lok ][ Canca

Pic 3. Specifying enumeration settings for an individual IP
Range

e

The Via IP Range dialog allows you to specify the domain or workgroup the IP range belongs to
along with the Network Provider and the starting IP address. You can specify if the IP addresses to
process is ranged and if so than provide the ending IP. It is also possible to resolve the IP addresses
to host names. Press OK button to add the range.

You can add as many ranges as you want and then press OK button to proceed with enumeration.
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Enumerate via Domain

With Network Inventory it is also possible to scan only a specific domain or workgroup for Machines.
This goal can be reached using the Enumerate via Domain functionality. To proceed with such
enumeration choose Enumerate via Domain option from the drop-down options of Enumerate
LAN button on the tool bar above the Machine Tree. The Enumerate via Domain dialog will

appear on the screen.

.

Enumerate via Domain

==

Select a domain
endneration will have their data lost.
Prervider
Mictosoll Wirndows Network

D carvissin S ek griosip
DREAMLIGHT

i All the Mactines from the Domain ot found whie SR

44

| ok ]| cocal

e

Pic 4. Specifying the group to enumerate

In the Enumerate via Domain dialog you are to specify the group to enumerate along with the
network provider it belongs to. After you have specified the required information press OK button to

proceed.
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Fetching new Machines

Network Inventory along with the network enumeration provides you with an ability of scanning the
whole network or specific groups for the newly added Machines, those that are not available in the
Machine Tree, without loosing inventory information on the Machines that are not reachable now.
This approach is reached using the Fetch New feature. You can always review the latest fetched
machines using the appropriate node in the Machine Tree. There are two possible ways of
searching for new Machines and both of them are described in this chapter.

Fetch New

The Fetch New option allows you to search for new Machines within specific groups. To perform
such kind of a search press Fetch New button on the tool bar above the Machine Tree. The Fetch
New Machines dialog will appear on the screen.

Fetch Mew Machines |t |
Manage domains for fetching <
Nieve machings wil be fetched within domens Ested below, :iﬂ
[ Ineen [2 Et [2 Delete
| | Provides Domain |
Micicsoft Windows Hetwodk
T

Pic 1. Specifying the groups to fetch new Machines from

In the Fetch New Machines dialog it is possible to specify the groups to fetch new Machines from.
To add a group to scan press Insert button on the tool bar above the groups list. The Via
Machines dialog will appear on the screen.

Via Machines ﬂ
Enter the domain name TS
The domain vill be added valth the name specied. "‘F—f
| g
(]
| Provide: Micosolt Windows Hetwork
Domain DREAMLIGHT
L_0¢ ][ Concel

Pic 2. Adding a group to fetch new Machines from
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A group name along with a network provider are to be specified to add a new group into fetching
process. After the required data is specified press OK button to proceed. The group is now added to
the list of groups to fetch new Machines from. You can add as many groups as you want. When you
are done press OK button to proceed with fetching.

After the fetch process is complete the Machines fetched will be available in the Machine Tree.

Fetch New via IP Range

Sometimes you face the situation when you do not need to fetch all the Machines from the network
but only some of them. In such a case you can use Fetch New via IP Range feature. To use such
kind of search choose Fetch New via IP Range option from the drop-down options of Fetch New
button on the tool bar above the Machine Tree. The Fetch New via IP Range dialog will appear on
the screen to specify the ranges to use.

Fetch New Via IP Range ]

Manage IP Ranges for fetching oo

| Mew machines vill be istched within IP Ranges isted below. LS
[ Inset [Z Ed [ Delste
Provides Diomain Resobve |
IF [From) IFTa Ranged |
DREAMLIGHT . m
15216851 | m |
Lok ) [ Conce |

Pic 3. Specifying the IP Ranges to be used in Machines
search

Copyright © 2001-2018 EMCO. All rights reserved. 30



Network Inventory Enterprise 5 Network Management

In the Fetch New via IP Range dialog you are to specify the ranges of IP addresses to be used in
search. You can add as many ranges as needed. To add a range press Insert button above the
ranges list. The Via IP Range dialog will appear on the screen.

[ Via 1P Range =)
Enter the IP Range details e
The |P Range wil be created acconding to the detals specified "'—*Ii
Provides Micaozodt Windows Medwork
Dormain DREAMLIGHT
IP [Froam) 192 16251
Ranged
IFTa
Riezohee to Host
Lok ]| conce

e

Pic 4. Specifying an individual IP Range to take part in
Machines search

The Via IP Range dialog allows you to specify the domain or workgroup the IP range belongs to
along with the Network Provider and the starting IP address. You can specify if the IP addresses to
process is ranged and if so than provide the ending IP. It is also possible to resolve the IP addresses
to host names. Press OK button to add the range.

When you have added all the ranges needed press OK button to proceed with the search.
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Latest Fetched Machines

With Network Inventory you can always see the Machines that were fetched lately. These
information is displayed within the Latest Fetched Machines dialog. This dialog by default
groups the Machines fetched by a fetching date but you can change the grouping any way you
want.

faf Latest Fetched Machines =,

Latest fetched machines e,
Review machines which were feiched beloes. A(H

L-Eam Ue;ua_

\LastErumnDa.. /|

8] Last Enwen D ate’\Time : 1/27/2010 1:26:29 PM
| Microsoft Windows Metwok  DREAMLIGHT MERCURIUS

Pic 5. Latest fetched Machines

To reach the Latest Fetched Machines dialog you can select Management Tools > Latest
Fetched Machines menu item from the application main menu or choosing the Latest Fetched
Machines node in the Machine Tree.
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Adding Machines Manually

If network scan is not a convenient way of adding Machines to the Machine Tree Network
Inventory provides you with an ability of adding Machines manually. To add Machines in such a way
press Add Machine(s) button from the tool bar above the Machine Tree. The Add Machine(s)
dialog will appear on the screen.

[ Add Machine(s) S |
Specify machines for a selected domain =
[ Speciied machines vl be added o selected domann 4@‘;
Prosvides D omain/work geoup
Miciozolt Windows Network + DREAMLIGHT -
(3 wnset [ Edt [2 Detete | M oot [ Expon
Machine Name T |Descripion Custom Dat..| Custoe Dat...
[H |
Lok || Genea |

Pic 1. Adding machines manually

In the Add Machine(s) dialog you can add as many Machines as you wish one by one or import the
list of Machines from a file to the specified group. To add a single Machine press Insert button
above the Machines list. The Add Machine dialog will appear on the screen.

Add Machine (S
_[ Enter machine name and its data -~"‘.'.-
| Machine wilbe added i the name and data LG
specified, :
M achine Name: MERCURILS
Uzer Data
Descnption:
Cugstom Datal:
Cussbomn Dataz:
Lo ][ Concel | J

Pic 2. Adding a single Machine
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The Add Machine dialog allows you to specify the Machine host name to add and its description.

As it was mentioned earlier the other way of adding Machines is importing from a file. To import
Machines press Import button on the tool bar above the Machines list. The dialog will open to
browse to a file with a list of Machines.

When you are ready with filling the Machines list with Machines you want to add press OK button to
proceed. Optionally you can export this list to a file for a further import using the Export button on
the tool bar above the Machines list.

Removing red mark from manually added Machines

As Machines are added manually they are marked with a red cross - this means that these Machines
were not scanned for inventory information. To remove this mark you should update these Machines.
To update select these Machines in the Machine Tree and select Update Offline Only options from
the drop-down of the Update button on the tool bar above the Machine Tree.
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Chapter 5: Inventory Information Management

The main goal of Network Inventory is to help you collect inventory information all over the network
with least effort. With Network Inventory it is possible to retrieve both software and hardware
information from remote Machines along with system information. The options defining what to
collect are specified on the Settings tab on the left of the main application screen. This chapter is
describing the range of information that can be retrieved with the example of the retrieved one for
each aspect.

What's Inside

Brief Scan

Detailed Scan

Custom Scan

Updating Scan Data

Installed Applications Inventory Features
Using Notes for Machines

How can I get Inventory Information for not connected Machines?

Brief Scan

Network Inventory allows to retrieve a lot of inventory information of different kind. First of all we
would like to introduce to you the brief scan options that allow to collect basic software, hardware
and system information. The brief scan options are available on the Settings tab.

The Brief Scan Options consists of the Machine's MAC address, basic information about the mother
board, memory, video system, operating system, BIOS and other. This chapter will describe the
Brief Scan Options in details.

What's Inside

Basic Information
Summary Hardware Information
Summary Software Information

Summary System Information
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Basic Information

Basic information is Machine's name, MAC and IP addresses along with the group name the Machine
belongs to. Optionally while editing the basic information it is possible to specify two custom fields
and description for the Machine that can help you while the inventory process. To retrieve basic
information about the Machine first of all check the Basic Information option on the Settings tab
under the Machine Information Scan Options. Then select the Machines you want to retrieve
basic info for and choose Update Selected option from the drop-down of the Update button
located on the tool bar above the Machine Tree. As soon as the update process completes you are
about to see the basic information for the Machine by selecting it in the Machine Tree.

[E&., Machine Scan Date: 7/20/2011 1:41:30 FM
/ Edit| .= Read OnlyFields B AutoUpdate [} LockMachine |~ Report Fikll=4
Machine: MERCLRILIS IP-Address:  192.168.1.10
Domain|\ Workgroup: DREAMLIGHT MAC Address: 00-18F3-7F-1C-1D
Description: Custom Datal:
Custom DataZ:

Pic 1. Basic information about the Machine

The basic information is displayed in an orange part of the Machine information area. You can edit
this information using the Edit button on the management tool bar or create a report containing this
information. While editing the basic information it is possible to specify two custom fields that can
help you while the inventory process.
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Summary Hardware Information

Summary Hardware information consists of basic mother board, memory and video system
information. To retrieve basic hardware information about the Machine first of all check the
Summary Information option on the Settings tab under the Hardware Information Scan
Options. Then select the Machines you want to retrieve summary hardware information for and
choose Update Selected option from the drop-down of the Update button located on the tool bar
above the Machine Tree. As soon as the update process completes you are about to see the
summary hardware information for the Machine by selecting it in the Machine Tree.

&A. Machine : Scan Date: 7/20/2011 1:41:30PM
/ Edi | -+ Read Only Fields B Auto Updste [ Lock Machine Report |=
Machine: MERCURILS IP-Address: 192.168.1. 10
Domain|Workgroup: DREAMLIGHT MAC Address:  00-18F3-7F-1C-1D
Description: Custom Datal:
Custom Datal:
@' Hardware Information &
’ Mother Board & Processors == Physical Drives
System Name: ASUSTek Computer INC, PSGZ-MX Disk 0: SAMEUNG HDOE0H) ATA Device (74,53 G8)
Processor Intel(R) Core{TM)2 CPU 4300 @ 1.B0GHz = =
Processor #2: Inel(R) Core(TM2CPU 4300 @ 1L.80GH:  Logical Drives
_ Local Disk C: I 18,23 GB of 37.42 GB free
& Memory Local Disk D: | 48 35.75 GB of 37.11 G free
Total Memony: 2.00 GB o
Available Memory:  1.43GB &% Other
Hemory Slot 1/2: 1.00 GB installed  Capadty 4.00 G& Printer Fax
Memory Shot 22: 1.00 GB instaled  Capacty 4.00 GB Frinter g2: Microsoft XP5 Document Writer
Network Card: Marvel Yukon S3ER001/300 32010 PCI Gigabit
£ video System Ethernet Controler
HMonitors Syncvaster
Video Card: MNVIDIA GeForce 8500 GT
Resolution: 1250 1024

e A

Pic 1. Summary hardware information about the Machine

The basic hardware information is displayed in a green part of the Machine information area. You can
edit this information using the Edit button on the management tool bar or create a report containing
this information.

It is also possible to expand and collapse this part using the glyph on its header or hide this part
using the Hide Hardware Information button on the management tool bar.
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Summary Software Information

Summary Software information consists of operating system information such as OS name, version,
product key, language, default programs, etc. To retrieve basic software information about the
Machine first of all check the Summary Information option on the Settings tab under the
Software Information Scan Options. Then select the Machines you want to retrieve summary
software information for and choose Update Selected option from the drop-down of the Update
button located on the tool bar above the Machine Tree. As soon as the update process completes
you are about to see the summary software information for the Machine by selecting it in the

Machine Tree.

[Ev'L*-. Machine

Scan Date: 7/20/2011 1:41:30 PM

/ Edit | .+ Read OnlyFields B8 Auto Update ,m. Lock Maching Report
Machine: MERCURILS IP-Address: 192,163, 1.10
Domain| Workgroup: DREAMLIGHT MAC Address: 00-18 F3-7F-1C-10
Description: Custom Datal:

Software Information

- e
f_"ﬂp-eral:ing System
05 Name: Windows 7
05 Type: Works tation
Service Pack: Service Padk 1
Buikd Number: 7601
Product ID:
Digital Product 10:
Install Date: 2005-11-03

Custom Datad:

T Other
IExplorer Product 10:
Defaul Browser:
Windows Diréctory:
Profiles Directory:
Default Language:

IExpicre

'l:.:'ll'.‘a':l‘tdﬁ’xs

C:\Users

English (United States)

Pic 1. Summary software information about the Machine

The basic software information is displayed in a blue part of the Machine information area. You can
edit this information using the Edit button on the management tool bar or create a report containing

this information.

It is also possible to expand and collapse this part using the glyph on its header or hide this part

using the Hide Software Information button on the management tool bar.
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Summary System Information

Summary System information consists of BIOS information, information about the currently logged on
user, if any, auto admin settings, etc. To retrieve basic system information about the Machine first
of all check the Summary Information option on the Settings tab under the System
Information Scan Options. Then select the Machines you want to retrieve summary system
information for and choose Update Selected option from the drop-down of the Update button
located on the tool bar above the Machine Tree. As soon as the update process completes you are
about to see the summary system information for the Machine by selecting it in the Machine Tree.

[E-fk, Machine - Scan Date: 7/20/2011 1:41:30 PM
/ Edit | = ReadOnly Fields B AutoUpdate [y Lock Machine |~ Report & 3| )

Machine: MERCURIUS IP-Address:  152.168.1.10

DomainiWorkgroup: DREAMLIGHT MAC Address: 00-18+3-7F-1C-1D

Description: Custom Datal:

Custom Datal:

B’ System Information &
il s10s ../ Shares
Name: BIOS Date: 10/25/07 18:13:30 Ver: 08.00.10 ADMINS C:\Windows
Manufacturer: American Megatrends Inc. s c:\
Serial Number: SY5-1234567300 Ds [BH)
Version: A_M_I_- 10000725 1PCS
SMEB Version: 0901
SMB Major Version: 2 3 Auto Admin Settings
SMEB Minor Version: 3 Active: Mo
4, Logged-on User J’ Other
User Name: AlexEOREAMLIGHT System UpTime 2 Hours, 25 Minutes, 18 Seconds
Programs Directory:  C:\Users\Alex\AppData\Roaming WMicrosoft\wi  Current Users Alex
ndows\Start Menu\Programs Time of Day 201107-20 13:41:31
Scr.Saver Active: Yes

?s User Accounts

Admin Admin L
Administrator Admin E
Guest Guest

User Uiser

Pic 1. Summary system information about the Machine

The basic system information is displayed in a peachy part of the Machine information area. You can
edit this information using the Edit button on the management tool bar or create a report containing
this information.

It is also possible to expand and collapse this part using the glyph on its header or hide this part
using the Hide System Information button on the management tool bar.
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Detailed Scan

Frequently basic information is not enough for inventory reports and EMCO fully understand this.
That is why Network Inventory comes with a wide range of detailed scan options that allow you to
collect almost everything about the software and hardware installed on remote Machines along with
their configuration. All detailed scan options are located on the Settings tab. This part of the
manual is to describe the range of detailed scan options and show you how much information can
you include in your inventory reports without any serious effort.

What's Inside

Installed Applications
Application Updates
Shares

Monitors

Printers

Drive Mappings
Physical Drives
Logical Drives

CD Drives

Running Processes
Startup Commands
Program Folders
Processors

Network Cards
Environment Variables
Services

Memory Banks
ODBC Data Sources
Scheduled Tasks
Fonts

User Accounts

Network Protocols
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Installed Applications

Network Inventory allows you to collect information on the applications installed on any Machine so
you do not need to rewrite the whole list of applications from the Add/Remove Programs section of
the Operating System during the inventory. To get a list of installed applications first of all check
the Installed Applications option on the Settings tab under the Software Information Scan
Options. Then select the Machines you want to retrieve installed applications list for and choose
Update Selected option from the drop-down of the Update button located on the tool bar above
the Machine Tree. As soon as the update process completes you are about to see the installed
applications list for the Machine by selecting its Installed Applications child node in the Machine
Tree.
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Pic 1. The list of installed applications for the Machine

You can add applications to this list manually, remove the applications from this list, edit each
application info, export this list to any format or create a report containing this information.
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Application Updates

Network Inventory allows you to collect information on the application updates installed on any
Machine. To get a list of application updates first of all check the Application Updates option on
the Settings tab under the Software Information Scan Options. Then select the Machines you
want to retrieve a list of application updates for and choose Update Selected option from the
drop-down of the Update button located on the tool bar above the Machine Tree. As soon as the
update process completes you are about to see the application updates list for the Machine by
selecting its Application Updates child node in the Machine Tree.
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Pic 1. The list of application updates for the Machine

You can add a application update to this list manually, remove the application update from this list,
edit application update info, export this list to any format or create a report containing this

information.
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Shares

Network Inventory allows you to collect information on the shares available on any Machine. To get
a list of shares first of all check the Shares option on the Settings tab under the System
Information Scan Options (optionally you can also check Include Share Access to retrieve
access rights). Then select the Machines you want to retrieve shares list for and choose Update
Selected option from the drop-down of the Update button located on the tool bar above the
Machine Tree. As soon as the update process completes you are about to see the shares list for
the Machine by selecting its Shares child node in the Machine Tree.
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Pic 1. The list of shares for the Machine

You can add a share to this list manually, remove the share from this list, edit each share info,
export this list to any format or create a report containing this information.
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Monitors

Network Inventory allows you to collect information on the monitors available on any Machine. To
get a list of monitors first of all check the Monitors option on the Settings tab under the
Hardware Information Scan Options. Then select the Machines you want to retrieve monitors list
for and choose Update Selected option from the drop-down of the Update button located on the
tool bar above the Machine Tree. As soon as the update process completes you are about to see
the monitors list for the Machine by selecting its Monitors child node in the Machine Tree.
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Pic 1. The list of monitors for the Machine

You can add a monitor to this list manually, remove the monitor from this list, edit each monitor info,
export this list to any format or create a report containing this information.
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Printers

Network Inventory allows you to collect information on the printers available on any Machine. To get
a list of printers first of all check the Printers option on the Settings tab under the Hardware
Information Scan Options. If you would like to include network printers to the inventory check
Include Network Printers option. Then select the Machines you want to retrieve printers list for
and choose Update Selected option from the drop-down of the Update button located on the tool
bar above the Machine Tree. As soon as the update process completes you are about to see the
printers list for the Machine by selecting its Printers child node in the Machine Tree.
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Pic 1. The list of printers for the Machine

You can add a printer to this list manually, remove the printer from this list, edit each printer info,
export this list to any format or create a report containing this information.
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Drive Mappings

Network Inventory allows you to collect information on the drive mappings available on any Machine.
To get a list of mapped network drives first of all check the Drive Mappings option on the Settings
tab under the System Information Scan Options. Then select the Machines you want to retrieve
a list of mapped drives for and choose Update Selected option from the drop-down of the Update
button located on the tool bar above the Machine Tree. As soon as the update process completes
you are about to see the mapped drives list for the Machine by selecting its Drive Mappings child
node in the Machine Tree.
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Pic 1. The list of mapped drives for the Machine

You can add a mapped drive to this list manually, remove the mapped drive from this list, edit each
drive info, export this list to any format or create a report containing this information.
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Physical Drives

Network Inventory allows you to collect information on the physical drives available on any Machine.
To get a list of physical drives first of all check the Physical Drives option on the Settings tab
under the Hardware Information Scan Options. Then select the Machines you want to retrieve a
list of physical drives for and choose Update Selected option from the drop-down of the Update
button located on the tool bar above the Machine Tree. As soon as the update process completes
you are about to see the physical drives list for the Machine by selecting its Physical Drives child

node in the Machine Tree.
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Pic 1. The list of Physical drives for the Machine

You can add a physical drive to this list manually, remove the physical drive from this list, edit each

drive info, export this list to any format or create a report containing this information.
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Logical Drives

Network Inventory allows you to collect information on the logical drives available on any Machine.
To get a list of logical drives first of all check the Logical Drives option on the Settings tab under
the Hardware Information Scan Options. Then select the Machines you want to retrieve a list of
logical drives for and choose Update Selected option from the drop-down of the Update button
located on the tool bar above the Machine Tree. As soon as the update process completes you are
about to see the logical drives list for the Machine by selecting its Logical Drives child node in the
Machine Tree.
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Pic 1. The list of logical drives for the Machine

You can add a logical drive to this list manually, remove the logical drive from this list, edit each
drive info, export this list to any format or create a report containing this information.
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CD Drives

Network Inventory allows you to collect information on the CD drives available on any Machine. To
get a list of CD drives first of all check the CD Drives option on the Settings tab under the
Hardware Information Scan Options. Then select the Machines you want to retrieve a list of CD
drives for and choose Update Selected option from the drop-down of the Update button located
on the tool bar above the Machine Tree. As soon as the update process completes you are about

to see the CD drives list for the Machine by selecting its CD Drives child node in the Machine Tree.
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Pic 1. The list of CD drives for the Machine

You can add a CD drive to this list manually, remove the CD drive from this list, edit each drive info,
export this list to any format or create a report containing this information.
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Running Processes

Network Inventory allows you to collect information on the processes running now on any Machine
as you've made a screen shot with the Task Manager of the Operating System during the inventory.
To get a list of running processes first of all check the Processes option on the Settings tab under
the System Information Scan Options. Then select the Machines you want to retrieve a list of
running processes for and choose Update Selected option from the drop-down of the Update
button located on the tool bar above the Machine Tree. As soon as the update process completes
you are about to see the processes list for the Machine by selecting its Running Processes child
node in the Machine Tree.
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Pic 1. The list of running processes for the Machine

You can add a process to this list manually, remove the processes from this list, edit each each
process info, export this list to any format or create a report containing this information.
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Startup Commands

Network Inventory allows you to collect the commands to be run on the Operating System start up
for any Machine. To get a list of startup commands first of all check the Startup Commands option
on the Settings tab under the System Information Scan Options. If you also want to collect the
information on the commands to be run for the currently logged on user, you should check Current
User option under the Startup Commands one. Then select the Machines you want to retrieve a
list of startup commands for and choose Update Selected option from the drop-down of the
Update button located on the tool bar above the Machine Tree. As soon as the update process
completes you are about to see the startup commands list for the Machine by selecting its Startup
Commands child node in the Machine Tree.
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Pic 1. The list of startup commands for the Machine

You can add a startup command to this list manually, remove the startup command from this list,
edit each command, export this list to any format or create a report containing this information.
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Program Folders

Network Inventory allows you to collect information on the folders available from the Program Files
folder of the operating system on any Machine. To get a list of program folders first of all check the
Program Folders option on the Settings tab under the Software Information Scan Options.
Then select the Machines you want to retrieve a list of program folders for and choose Update
Selected option from the drop-down of the Update button located on the tool bar above the
Machine Tree. As soon as the update process completes you are about to see the program folders
list for the Machine by selecting its Program Folders child node in the Machine Tree.
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Pic 1. The list of program folders for the Machine

You can add a folder to this list manually, remove the folder from this list, edit each program folder,
export this list to any format or create a report containing this information.
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Processors

Network Inventory allows you to collect information on the processors available on any Machine. To
get a list of processors first of all check the Processors option on the Settings tab under
theHardware Information Scan Options. Then select the Machines you want to retrieve a list of
processors for and choose Update Selected option from the drop-down of the Update button
located on the tool bar above the Machine Tree. As soon as the update process completes you are
about to see the processors list for the Machine by selecting its Processors child node in the

Machine Tree.
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Pic 1. The list of processors for the Machine

You can add a processor to this list manually, remove the processor from this list, edit processor
info, export this list to any format or create a report containing this information.
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Network Cards

Network Inventory allows you to collect information on the network cards available on any Machine.
To get a list of network cards first of all check the Network Cards option on the Settings tab
under the Hardware Information Scan Options. Then select the Machines you want to retrieve a
list of network cards for and choose Update Selected option from the drop-down of the Update
button located on the tool bar above the Machine Tree. As soon as the update process completes
you are about to see the network cards list for the Machine by selecting its Network Cards child
node in the Machine Tree.
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Pic 1. The list of network cards for the Machine

You can add a network card to this list manually, remove the network card from this list, edit
network card info, export this list to any format or create a report containing this information.
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Environmental Variables

Network Inventory allows you to collect information on the environmental variables registered in the
Operating System on any Machine. To get a list of environmental variables first of all check the
Environmental Variables option on the Settings tab under the System Information Scan
Options. If you want to collect also the variables for the currently logged on user and shell folders
select the following options under the Environmental Variables one. Then select the Machines
you want to retrieve a list of environmental variables for and choose Update Selected option from
the drop-down of the Update button located on the tool bar above the Machine Tree. As soon as
the update process completes you are about to see the environmental variables list for the Machine
by selecting its Environmental Variables child node in the Machine Tree.
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Pic 1. The list of environmental variables for the Machine

You can add a environmental variable to this list manually, remove the environmental variable from
this list, edit each variable, export this list to any format or create a report containing this

information.
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Services

Network Inventory allows you to collect information on the services registered in the Operating
System on any Machine. To get a list of services first of all check the Services option on the
Settings tab under the System Information Scan Options. Then select the Machines you want to
retrieve a list of services for and choose Update Selected option from the drop-down of the
Update button located on the tool bar above the Machine Tree. As soon as the update process
completes you are about to see the services list for the Machine by selecting its Services child
node in the Machine Tree.

[ EMCO Network Inventory Enterprise
| Options

Power your business with up-to-date inventory information
Inteligent inmsenbory sisbem for keeping ack of your handware and soltware assels scrogs the network, amdime,

() Enumerate LAN ~ (G FelchNew = @ Updue =
= B|X o Aclions « S0 Services
- L Add

- Ertie Metwork - (23] : :
B Instaled Appbzalions 2 j dlete | 4 Export Displayed Services: 68
] Custom Sean Results [sm l'_'“ il
Bl Shares Senvice Name /||| Display Mame * | Slatup w | Logon As - | Las
J i B Monkors [EelogkusSve Apphcaion Expenenc. Aulo LocalSystem 72

- Prirters Aeer Aetier Disabled NT AUTHORITY \LocalService 172

125 Diive Mappings - 0 |
s Liogieal Diifves AppMgri Application Managem.. Demand LocalSystem 2=

| File View Ee EQLQueryilﬂer Scan Operations  Management Tools Live Update Help

|5 00 Diives HAudoSiy Windows Audio Ao LocalSystem 12
:4] ﬁ Rluning P BITS Background Intelgert... Demand LocalSystem 172
& Esm C 4 Broweser Compader Browses Ao LocalSystem 172
- Program Foldess E CiSve Indeing Service Disabled LocalSpstenm 12
5 Processoes CryplSwe Ciyptographic Services  Aulo LocalSystem 12
] e Metweonk: Cards DeomLaunch DCOM Serves Process.. Aulo LocalSysten 172

| 1 B8, Envirormental Vasiables Dhep DHCP Chent Ao NT AUTHORITY \NetworkSer... 1/2
=15y Services dmadrrin Logical Disk Manager ... Demand LocalSysem 142

- DEV dmserver Logieal Dick Manager  Aulo LocatSystam 12
=¥ DREAMLIGHT Dnscache DMS Chent Ao WT AUTHORITY \NetwoikSer,. 1/2
= DREAMLIGHT-FOC ERSve Eino Flepoiting Seivice  Aulo LocalSystem 12

| MERCURILS Eventlag Event Log At LocalSysten 12

B Ww2000-5P4 EventSystem COMs+ Event System  Auin LocalSystem 172

o 2 WHPPROMEASP1 hefpive Help snd Suppoit  Auto LocatSystem 12
g4 EMCO HidSery Huenan Inteiace Devi., Disabled LocaiSystem 172
E = ﬂ S HTTRFites HTTP 5L Demand LocalSystem 72
& .;1 TYRONE &5 ) et 45 Jet Database Ace.., Demand LocalSystem 12

e ';1 WINTOOLEIT idsve ‘Windows CardSpace  Demand LocalSysten 172

| H:amﬂﬂs kde Kesbesos Key Distrbuti.. Ao LocalSystem 12 E

| @ ) ODBC Data Sowces . -| l?wmsew Sedved — Al LocalSusten 1;’2
o Setes (8 Codoi |
5 dedait o

Pic 1. The list of services for the Machine

You can add a service to this list manually, remove the service from this list, edit each service info,
export this list to any format or create a report containing this information.
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Memory Banks

Network Inventory allows you to collect information on the memory banks available on any Machine.
To get a list of memory banks first of all check the Memory Banks Info option on the Settings tab
under the Hardware Information Scan Options. Then select the Machines you want to retrieve a
list of memory banks for and choose Update Selected option from the drop-down of the Update
button located on the tool bar above the Machine Tree. As soon as the update process completes
you are about to see the memory banks list for the Machine by selecting its Memory Banks child

node in the Machine Tree.
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Pic 1. The list of memory banks for the Machine

You can add a memory bank to this list manually, remove the

memory bank from this list, edit

memory bank info, export this list to any format or create a report containing this information.
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ODBC Data Sources

Network Inventory allows you to collect information on the ODBC data sources available on any
Machine. To get a list of ODBC data sources first of all check the ODBC Data Sources option on
the Settings tab under the System Information Scan Options. Then select the Machines you
want to retrieve a list of data sources for and choose Update Selected option from the drop-down
of the Update button located on the tool bar above the Machine Tree. As soon as the update
process completes you are about to see the data sources list for the Machine by selecting its ODBC
Data Sources child node in the Machine Tree.
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Pic 1. The list of ODBC Data Sources for the Machine

You can add an ODBC data source to this list manually, remove the ODBC data source from this list,
edit data source info, export this list to any format or create a report containing this information.
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Scheduled Tasks

Network Inventory allows you to collect information on the tasks being scheduled in the Operating
System on any Machine. To get a list of scheduled tasks first of all check the Scheduled Tasks
option on the Settings tab under the System Information Scan Options. Then select the
Machines you want to retrieve a list of scheduled tasks for and choose Update Selected option
from the drop-down of the Update button located on the tool bar above the Machine Tree. As
soon as the update process completes you are about to see the tasks list for the Machine by
selecting its Scheduled Tasks child node in the Machine Tree.
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Pic 1. The list of scheduled tasks for the Machine

You can add a scheduled task to this list manually, remove the scheduled task from this list, edit
each task info, export this list to any format or create a report containing this information.
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Fonts

Network Inventory allows you to collect information on the fonts installed in the Operating System
on any Machine. To get a list of fonts first of all check the Fonts option on the Settings tab under
the System Information Scan Options. Then select the Machines you want to retrieve a list of
fonts for and choose Update Selected option from the drop-down of the Update button located on
the tool bar above the Machine Tree. As soon as the update process completes you are about to

see the fonts list for the Machine by selecting its Fonts child node in the Machine Tree.
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Pic 1. The list of fonts for the Machine

You can add a font to this list manually, remove the font from this list, edit font info, export this list
to any format or create a report containing this information.
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User Accounts

Network Inventory allows you to collect information on the user accounts known by the Operating
System on any Machine. To get a list of user accounts first of all check the User Accounts option
on the Settings tab under the System Information Scan Options. Then select the Machines you
want to retrieve a list of accounts for and choose Update Selected option from the drop-down of
the Update button located on the tool bar above the Machine Tree. As soon as the update
process completes you are about to see the user accounts list for the Machine by selecting its User
Accounts child node in the Machine Tree.
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Pic 1. The list of user accounts for the Machine

You can add a user account to this list manually, remove the user account from this list, edit
account info, export this list to any format or create a report containing this information.
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Network Protocols

Network Inventory allows you to collect information on the network protocols available on any
Machine. To get a list of network protocols first of all check the Network Protocols option on the
Settings tab under the System Information Scan Options. Then select the Machines you want to
retrieve a list of protocols for and choose Update Selected option from the drop-down of the
Update button located on the tool bar above the Machine Tree. As soon as the update process
completes you are about to see the network protocols list for the Machine by selecting its Network
Protocols child node in the Machine Tree.
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Pic 1. The list of network protocols for the Machine

You can add a network protocol to this list manually, remove the network protocol from this list, edit
protocol info, export this list to any format or create a report containing this information.
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Custom Scan

Along with the Brief Scan and Detailed Scan Network Inventory provides you with an ability of
running custom File System and Registry scans. Such scans allow you to find the file system and
registry items that match the defined criteria on any Machine.

Custom scans can be really useful if you are going to detect policy violations, for example using
some portable hacked programs at work place or storing entertainment data on the Machines. This
chapter will guide you through the process of creating and executing custom scans.

What's Inside

File System Scan
Registry Scan

Custom Scan Criteria
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File System Scan

File system scan feature of Network Inventory provides you with an ability of searching for the file
system items matching a defined criteria any time you want. File system scan capabilities can be
accessed by selecting the File System Scan node under the Scan Operations node of the
Machine Tree. The File System Scan area will appear on the right of the application screen
showing you the list of scan tasks. This part will guide you through creating, configuring and
executing custom File System Scans.
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Pic 1. File system scan tasks list
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Creating a File System Scan

To create a new file system scan select File System Scan node under the Scan Operations node
of the Machine Tree and press Add button on the tool bar of the File System Scan area. The Add
Scan Task dialog will appear on the screen.
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Pic 2. Creating a File System Scan
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In the Add Scan Task dialog you are proposed to provide a scan name and description. The scan
created will contain the criteria to match and the Machines to scan for the items matching the
criteria along with the scan results. You can then execute this scan as many times as you want.
When you are ready with filing the data required press OK button to proceed. When the task is
added the view is automatically switched to the task configuration. In the Task Details area
you are to specify a criteria, Machines to take part in scan and review scan results.
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Pic 3. The task details area

The Tasks Details area consists of three parts. These are the Machine Queue B, Scan Criteria
3 and Scan Results @ panes. The Machine Queue pane shows you the Machines to take part in
the scan task, the Scan Criteria pane manages the list of criteria to be used for scan task and
Scan Results pane contains the list of task execution results.
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